
CJV150/300/300 Plus Metallic Color Printing Guide

This manual describes the effects that can be expressed when silver ink is used in CJV150/300/300 Plus, and
how to set and print them.
Please read this manual carefully and use it correctly.

Note
• It is strictly prohibited to write or copy a part or whole of this document without our approval.
• This document has been carefully prepared for your easy understanding, however, please do not hesitate to

contact a distributor in your district or our office if you have any inquiry.
• Description contained in this document are subject to change without notice for improvement.
• Copying the Mimaki Engineering Co. Ltd. software described in this guide to other disks (except for backup

purposes) or loading it to memory except for the purpose of running it, is strictly prohibited.
• Due to improvement or change of software, the description of this document could be partially different in

specification, for which your understanding is requested.
• With the exception of what is provided for in the warranty provisions of MIMAKI ENGINEERING CO., LTD., we do

not assume any liability against the damages (including but not limited to the loss of profit, indirect damage,
special damage or other monetary damages) arisen out of the use or failure to use of this product. The same shall
also apply to the case even if MIMAKI ENGINEERING CO., LTD. had been notified of the possibility of arising
damages in advance. As an example, we shall not be liable for any loss of the media made using this product or
indirect damages caused by the product made using this media.

• You can also download the latest operation manual from our website.

Notations used in this document
• Items and buttons displayed in menus and on screens are marked with square brackets ([ ]) as in [File].

Screen image used in this document
• The explanation is based on the screen image of RasterLink6Plus as an example.
• RasterLink6Plus and RasterLink7 are referred to as RasterLink in together.

Symbols

RasterLink is the trademarks or registered trademarks of MIMAKI ENGINEERING CO., LTD. in Japan and in other
countries.
Adobe, the Adobe logo, Acrobat, Illustrator, Photoshop, and PostScript are the trademarks or registered trademarks
of Adobe Systems Incorporated in the United States and other countries.
CorelDRAW is a trademark or registered trademark of Corel Corporation in Canada, the United States and other
countries, and its affiliates.
Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation of the United States and
other countries.
Apple and Macintosh are trademarks or registered trademarks of Apple Inc. of the United States and other coun-
tries.
Other company and product names mentioned herein are the trademarks or registered trademarks of the respective
companies in Japan and in other countries.

• This symbol indicates important information for using this product.

• This symbol indicates useful information.
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Before printing the silver ink, please check first

Printer setting
Make the following settings on this machine.

 For setting "OFF" the [LOGICAL SEEK]
By setting the logical seek, operation of the head will change at the time of print. For details, refer to the
Operation manual of this machine.

 Set the [DRYING TIME] to "0.0 seconds"
For setting the drying time of ink. For details, refer to the Operation manual of this machine.

1. Turn on the machine.
• For details, refer to Chapter 2 “Turning the Power On” in 

this machine's Operation manual.

2. Set of the [LOGICAL SEEK].

(1) In local, press  (MENU) .
• Display the “SETUP MENU”.

(2) Press  3 times, then press .
• “LOGICAL SEEK” is selected.

(3) Press  to select  “OFF”, then press .
• Return to [SETUP MENU] screen.

3. Setting of [DRYING TIME].

(1) Press  once, then press .
• “DRYING TIME” is selected.

(2) Press  to select “SCAN”, then press .
• Setting screen of drying time is displayed.

(3) Press  to set drying time to “0.0s”, and then press .

4. Press  several times to return to [LOCAL].

Power supply switch
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Confirmation of appropriate printing conditions
The color of the print using the SS21 silver ink is very different from the color to be displayed in the preview of
the application.
Because there is image quality varies depending on the media you want to use, you need to make sure the
first printing conditions suitable for the media.
After confirming the printing conditions, it is recommended that you create a color swatch of silver
monochromatic and metallic color in printing conditions suitable for the media.
 Create a silver monochromatic color swatch

Even in the case of media that do not have a metallic color profile, in order to use your silver ink effectively,
please output the following color swatch and check the print condition that matches the media.
Here, explain the procedure to print a two-layer print.

1. Check the setting of Color Collection.
• Choose [Color Collection ...] from [Tool] menu.

2. Make sure that the use columns of "SS21 
Metallic Color" and "MIMAKI RasterLink" are 
checked.

• Put a check if the use columns are not checked.

3. Select [Open...] from [File] menu of 
RasterLink.

4. Select the image in the following folder, and then click  button.
• C:\MijSuite\ColorChart\Default\SilverInkLimiTestChart.pdf

5. From [Job List] panel, select the image (job) 
that is read.

6. Click [Layer]  icon.

Open
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7. In [Layer Adjust] panel, select the "Special 
Color → Color" for [Special Color Over 
Print].

8. Click [Quality]  icon.

9. In [Print Quality] panel, set the printing condition.
(1) Select a metallic color profile for the media to be used or of the same material as the media to be

used.

(2) In [Device Adjustment], select “Profile Setting”.

(3) Select the “ColorMatching OFF” in the preset of [Color Matching].

10. Click [Execution]  icon.

11. In [Execution] panel, select  “RIP and Print”, 
and then click  button.

• Metallic color profile will have a [Si] to the end of the media name. 

(3)
(1)

(2)

Start



- 6 -

12. Check the image quality of printed silver monochromatic color swatches.

13. Click [Quality]  icon.

14. Click [Color Adjust] tab.

• Create a new [Color Adjustment Set].

15. Adjust the concentration of silver ink.

16. Go back to Step 10, to print again.

How to check the quality of the silver ink
• The patch of silver monochromatic color swatches, of which color concentration is 100% and does 

not occur the bleeding, banding and blurring,  and form a uniform print surface can match the 
printing conditions of the media to be used.
Please use this as a color swatch of silver.
If the image quality of 100% of the patch is bad, please proceed to Step 13.

Bleeding :Many ink amount, or it becomes whitish full of ink at the edge of the patch.
Roughness :Ink amount is insufficient, such as hoarse roughness occurs.
Banding : Ink is insufficient, stripes occurs in scan direction.

Method of adjustment the concentration of silver ink
• If the bleeding at 100% of the patch in step 9 has occurred, see a patch of silver monochromatic 

color swatches, and look for the concentration that image quality is good. 
Reduce the silver ink concentration to match the concentration of the patch. 
Example) A good image quality at 70% → setting 

value : -30%

• The roughness and banding at 100% of the patch in step 9 have occurred, increase the 
concentration of Silver ink.

Example) setting value: + 10% (the silver ink amount can be changed between -50% ~ + 50%).

• If the adjustment of the concentration of silver ink not improve image quality in step15, select a 
metallic color profile for another media, then try again from step 9.

Example of good 
image quality Example of poor image quality 

Bleeding Roughness Banding
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 Print a color swatch of metallic color
You can print a color swatch of metallic color swatch which can be used in Adobe Illustrator.
You can check the settings of the print to overlay the color ink in silver ink.  
Here, explain the procedure to print a two-layer print.

1. Check the setting of Color Collection.
• Choose [Color Collection ...] from [Tool] menu.

2. Make sure that the use columns of "SS21 
Metallic Color" and "MIMAKI RasterLink" are 
checked.

• Put a check if the use columns are not checked.

3. Read the PDF of metallic color collection.
• Choose [Open] from [File] menu.

4. Select one of the following five types in the folder of the image, and click 
the  button.

• C:\MijSuite\ColorChart\Default
(1) Metallic Color Collection A.pdf
(2) Metallic Color Collection B_1.pdf

Metallic Color Collection B_2.pdf
Metallic Color Collection B_3.pdf

(3) MetallicColorCollectionB_OrInkEdition.pdf
(4) Metallic Color Collection C.pdf
(5) MetallicColorCollectionC_OrInkEdition.pdf

• Check “SS21 Metallic Orange Color” as well when using orange ink.

This is a pattern covering all SS21  metallic color library.
(1) Metallic Color Collection A

Can confirm the finish of metallic color. 

Open
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5. Click [Layer]  icon.

(2) Metallic Color Collection B_1
Metallic Color Collection B_2
Metallic Color Collection B_3

Can be used as a seal-shaped sample. 
The concentration of CMYK each color is also 
described.
When you create a booklet, cut after the 
lamination process.  
Can cut to be on A4-size booklet.

(3) MetallicColorCollectionB_OrInkEdition
Can be used as a seal-shaped sample as with the 
color chart in (2).
Use orange ink to print.

(4) Metallic Color Collection C
Can be used as a color swatch in the small
bundles. 
The concentration of CMYK each color is also
described. 
When you create a booklet, cut after the
lamination process.

(5) MetallicColorCollectionC_OrInkEdition
Can be set in small bundles and used as a color 
swatch as with the color chart in (4).
Use orange ink to print.
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6. In [Layer Adjust] panel, select the "Special 
Color → Color" for [Special Color Over 
Print].

 

7. Click [Quality]  icon.

8. In [Print Quality] panel, set the printing condition.
(1) Choose a metallic color profile.

(2) In [Device Adjustment], select  “Profile Setting”.

(3) Select the "ColorMatching OFF" in the preset of [Color Matching].

9. Click [Execution]  icon.

10. Select [Execution] in the tab "RIP and Print", and then click the  button.

• Metallic color profile will have a [Si] to the end of the media name.

• When you print by adding a print information label, you can check the date and print conditions 
printed with metallic color collection. 
In [Information label] screen, when check "Add Label", the 
print information label can be added to the print.

• If the density adjustment of silver ink is 
needed, specify the [Color Adjustment 

(3)
(1)

(2)

Start
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Preparation for the application

 Open a Swatch Library in the application
Make the Swatch that was printed in the color swatch of metallic color be used in applications.

In the case of Adobe Illustrator

1. Click the [Swatch Library Menu] button in 
the Swatches panel (window).

2. Click “Other Library...” menu.

3. Select a swatch file in the following folder.
• Folder location : C:\MijSuite\Swatch\Illustrator
• Swatch files : MIMAKI SS21 Metallic Color Library.ai

MIMAKI RasterLink Library.ai
MIMAKI SS21 Metallic Orange Color Library.ai

 Install the RasterLinkTools
For information about how to install RasterLinkTools, please refer to the separate “RasterLink installation
guide”.
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 Choose the color collection
Before read the job to RasterLink, select the metallic color collection that were in the way of printing a
metallic color.

In the case of 2-layer printed

1. Select the [Color Collection ...] from [Tool] 
menu of RasterLink.

• Use "SS21 Metallic Color" including the silver ink to 
the output.

2. Remove the check from the use of column 
"SS21 Metallic Color (No Silver)".

3. Click  button.

In the case of Pull-back printing
Use the "SS21 Metallic Color" of which concentration of Silver ink is 0 to output.

1. Select the [Color Collection ...] from [Tool] 
menu of RasterLink.

2. Remove the check from the use of column 
"SS21 Metallic Color".

3. Click  button.

• If you change the setting of color correction, it will not be reflected in the color replacement of 
existing jobs. 
If you want to apply a different color collection, re-create the job again.

• Also deselect “SS21 Metallic Orange Color(No 
Silver)” from the Use column when using orange ink.

• Also deselect “SS21 Metallic Orange Color” from the 
Use column when using orange ink.

Close

Close
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How to print metallic color
When you print the SS21 Silver ink in RasterLink by using the following three plates, there are two printing
methods.

1. 2-Layer printing
(1) Metallic color plate, color plate, and a silver plate printing at once.

2. Pull-back printing
(1) Printing color plate and a silver plate for the first time.

(2) Pull back the media.
(3) Print a metallic color plate for the second time.

Advantages and disadvantages comparison table of the two-layer printed and pulled back print

2-Layer printing Pull-back printing

Merit Color plate, Silver plate, and metallic color 
plate can be printed without deviation.

Improve the metallic tone more than 2-layer 
print.

Disadvantage
In the high part concentration of ink, metallic 
tone will be reduced.

Depending on the conditions, there is a 
case that color plate, silver plate, and metal-
lic color plate are printed displaced. *1

*1.Please refer to "Notes on Auto pull-back print" on the next page for more information.

Limit of print 
range

None Yes *1

Speed Equivalent to the Pull-back printing Equivalent to 2-layer printing

Metallic color plate : Color overlaying the silver ink

Color plate : Color which is not superimposed on the
silver ink

 Silver plate : Range of printing the silver ink
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Notes of Auto pull-back print
1. Prevent the displacement of image

In Pull-back printing, the image may be displaced in the first time and the second time of print. Please note
the following points.

1.1 Pinch roller position and number
Recommended conditions
• Media width is equal to or greater than 1000mm

As to be symmetrical with respect to the center of the media, more than four places.
• Media width is less than 1000mm

As to be symmetrical with respect to the center of the media, more than two places.
Set the roller pressure to "H" in any case.
If the roller number is less than above setting, it may cause the first and second image shifted.

1.2 Sheet feed
When the first time and the second time of print media of different tension, it will cause the image to
be shifted. 
By loosening the media that was set before print manually, the displacement of the image can be
reduced..

2. Size of image and limit of arrangement
Due to the pinch rollers and machinery on the structure, in the Pull-back printing there is a limit to the size
of the image that can be printed.

2.1 Width direction
With respect to the set the pinch roller, avoid the image to ride on the track of the roller.
When the pinch roller passes over the printed image, it will cause the roller trace is attached.

2.2 Feed direction
The maximum length of the print data is 1000mm.
If it is too long, the printing surface contacts with the floor and there is a risk of quality deterioration
such as dirt and rubbing.

3. About the quality of the image
Pull-back printing compared to the two-layer print can be used to improve the metallic tone by a longer
drying time of the silver plate, but quality vary by printing length.

• Printing length is 500mm or less
Set the print after the waiting time of about 5 to 15 minutes and you will be able to obtain a constant
quality.  (On the panel of the machine, dry time → print end,  set 300 ~ 900s.)

• Print length is longer than 500mm
Not need to set the print after the waiting time

• Printable range example of 1300mm media width:

Width of the printable range
390mm x 2, 340mm x 1 410mm x 2 800mm x 1

Pinch roller position 
(Unprintable)

Media 
(Unprintable for narrow width)

Printable range
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Let's printing using Silver
Here, by taking a concrete example, describes the flow from the creation of the data up to print.

2-Layer printing Reference page

Print the part of the 
illustration in Metallic color P.15

Print a part of the photograph 
in metallic color P.18

Print a pattern of Silver P.23

Want to print a character in 
the color of the color 
swatches of metallic color.

Want to print a sunflower in a 
metallic color.

Want to print a silver polka 
dots on black solid parts.
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Print a part of the illustrations in metallic color
This section describes this procedure from data creation to printing using the steps required to print the
character text of the illustration below in metallic color as an example.
By taking advantage of the swatch library of the metallic color, you can easily print the metallic color.

1. Create metallic color plate and color plate.
(1) Select a character on the application.

(2) Specify any color from the MIMAKI SS21 Metallic Color Library.

(3) Click [Setting] of RasterLinkTools.

(4) Setting screen is displayed.
1 Check [Print Special Color Layer]
2 Click [Setup] button.

(5) Click [Output to RasterLink] button of RasterLinkTools to save the hot folder of RasterLink.

• Please create always a data in CMYK mode.

Specify the word "OCEAN" to 
"S-07C" 

Specify the word "DEW" to 
"Cold_01"

1

2
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(6) The color plate and metallic color plate of the data
output to RL in step 1-(5) will be shown on the
RasterLink job list screen.

(7) Click [Color Replacement]  icon.

(8) In [Color Replacement] panel, confirm the spot color
name that you specified in step 1-(2) exists in the list
in [Spot color] tab.

2. Printing.

(1) Click [Layer]  icon.

(2) In [Layer Adjust] panel, select "Special Color → Color → Color" to [Special Color Over Print].

(3) Click [Quality]  icon.

(4) Choose the job of metallic color plate in [Job List]
panel of [Quality] panel.

• When doing so a composite image of color plate and 
metallic color plate will be formed automatically.

• Here you do not need to set the [Quality]. 
When change the profile in step 2-(5), it will be the default setting of quality.
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(5) Choose the job of metallic color plate in [Job List] panel of [Quality] panel.
1 Choose a metallic color profile.

2 In [Device Adjustment], select  “Profile Setting”.
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

(6) Choose the job of color plate in [Job List] panel of [Quality] panel.

(7) Set printing conditions with Print Quality tab.

(8) Click [Execution]  icon.
• Click  button.

• Metallic color profile will have a [Si] to the end of the media name.

• Please do not select the metallic color profile.
• Be sure to select the same resolution profile of the metallic color plate of the profile.

• If the density adjustment of silver ink is 
needed, specify the [Color Adjustment Set].

3
1

2

Start
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To print the part of the photo in metallic color
Here, create three data of the metallic color plate overlaying the silver ink, color is not superimposed on the
silver ink plate and the Silver plate.
You can print the metallic color regardless the Image (raster) data or illustrations (vector) data.

1. Specify the range to print the silver ink.
• Here, explain how to create a path using the RasterLinkTools.

(1) Select the image on the application, and click
[Outline Extraction] button of RasterLinkTools .

(2) Click  button.
• Adjust to make the range that you want to print the 

silver ink traceable.

(3) Make sure that the layer of contour path (RL Trace
Layer1) is finished.

• For the contour extraction function of 
RasterLinkTools, refer to the separate "RasterLink 
Reference Guide".

Metallic color plate

Color plate

Silver plate

Trace execute
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2. Create a Silver plate.
(1) Set the fill color of RL Trace Layer1 that was created in step 1 to "Black", and the  stroke color to

"no fill".

(2) Display only the outline path layer.

(3) Click [Output to RasterLink] button of
RasterLinkTools to save the hot folder.

3. Create a metallic color plate and color plate.
(1) Select the image and the layer (RL Trace Layer 1) of the silver plate.

(2) Click [die-cut] of RasterLinkTools.

• Layer of the Metallic color plate (RLMask Inversion 
Layer 1) and the layer of the color plate  (RL Mask 
Layer1) will appear.

• Print the silver ink to the location of the "Black" of fill color.
Please correct the path if the place you do not want to print the silver ink is in black.

• Click  for the layer that you want to hide.

• If you want to save to the hot folder, put the name of 
each plate in the file name for easy understanding.
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(3) Set to display only metallic color plate.

(4) Click [Output to RasterLink] button of
RasterLinkTools to save the hot folder.

(5) Set to display only color plate.

(6) Click [Output to RasterLink] button of
RasterLinkTools to save the hot folder.

4. Print by synthesized in RasterLink.
(1) Select Silver plate job from the  [Job List] panel.

(2) In [Properties] panel, change  [Job Attribute] to
"Mono Color". 
• Display [Job Attribute] dialog box.
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(3) In [Job Attribute] dialog box, set to print in silver ink monochromatic.

(4) From [Job List] panel, select 3 jobs, Silver plate,
metallic color plate, and color plate.

(5) Click [Composition]  icon.

(6) In [Composition] panel, the order of the job from the
bottom with the Silver plate → color plate → metallic
color plate, then click  button.

If you have created the data in RGB mode, you can not replace monochromatic color. 
Please create a silver plate with the following procedure.

(1) From [Job List] tab, select the job for Silver plate.

(2) Click [Special plate]  icon.

(3) Select "Valid Pixel" in [Created area] " and  "Silver" in 
[Ink], and click the button.
• The job of Silver plate is created.

 Conditions that can not be synthesized
• If you have set the number of copies to two or more
• Split Print
• Step-and-repeat
• If the set of the selected job and resolution is differ-

ent
• Multiple page job
• If you have selected more than one cut jobs

 If you can not set a separate profile printing 
conditions, synthesize according to the 
conditions of one of the job.

1. First, select  "Black" to 
replace the original color

2. Next, select "Silver" in color 
after the replacement

3. Click  button

Create

Metallic color plate

Color plate

Silver plate

Composite
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(7) Click [Layer]  icon.

(8) In [Layer Adjust] panel, select "Special Color → Color → Color" to [Special Color Over Print].

(9) Click [Quality]  icon.

(10) Choose the job of metallic color plate and silver plate
in [job list] panel of [Quality] panel.

(11) Set printing conditions with Print Quality tab.
1 Choose a metallic color profile.

2 In [Device Adjustment], specify the "profile settings".
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

• Here you do not need to set the [Quality]. 
When change the profile in step 4-(11), it will be the default setting of quality.

• Metallic color profile will have a [Si] to the end of the media name.

• If the density adjustment of silver ink is 
needed, specify the [Color Adjustment 

3
1

2
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(12) Choose the job of color plate in [job list] panel of
[Quality] panel.

(13) Set printing conditions with Print Quality tab.

(14) Click [Execution]  icon.
• Click  button.

To print the texture of silver
Here, using a swatch pattern of Illustrator, print the pattern of silver.

1. Create a silver plate.
(1) Select all the objects that you want to print the

texture of Silver.

(2) Click [Extract Frame] button of RasterLinkTools.

(3) Perform the following settings, and then click the
 button.

1 Set [Offset] to “0mm”.
2 Uncheck [Extract the Inside].

• Please do not specify the metallic color profile.
• Be sure to specify the same resolution profile of the 

metallic color plate of the profile.

• For frame extraction function of RasterLinkTools, 
refer to the separate "RasterLink Reference Guide".

Start

1

2
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(4) Create a layer of color plate and a silver plate.

(5) Divide the layer of color plate and a silver plate.
• Move the path that was created in step 1-(3) to the layer for silver plate.

(6) Display only silver plate.

• Select the layer, double-click, then you can change the name of layer.

• Click  for the layer that you want to hide.

1. Click

2. Appear new layer

Double click
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(7) The line of the path that you created in step 1-(3) to "None", and specify a set of fill color to any
of the swatch pattern in the swatch library.

(8) Click [Output to RasterLink] button of
RasterLinkTools to save the hot folder.

2. Create a color plate.
(1) In the Layers screen, duplicate the path for the Silver plate.

(2) Move the path that was duplicated in step 2-(1) to the layer for the color plate
• Move to the top of the object you want to print the pattern of silver.

(3) Display only color plate.

• If you want to save to the hot folder, put the name of 
each plate in the file name for easy understanding.

• Use monocrome to the swatch pattern.
• Print the silver ink to black place.

2. Click

1. Select the path for the 
Silver plate

3. Click the 
"Duplicate" ... "
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(4) Choose the path that was moved in step 2-(2).

(5) Click the[Edit Colors]-[Invert Colors] from the [Edit] menu.

(6) Display only color plate.

(7) Click [Output to RasterLink] button of
RasterLinkTools to save the hot folder.

3. Print by synthesized in RasterLink.
(1) Select Silver plate job that was created in step 1.

from [Job List] panel of RasterLink.

(2) In [Properties] pane, change [Job Attribute] to “Mono
Color”.
• Display [Job Attribute] dialog box.

Click

• Where you want to print the Silver ink, do not 
print the color ink.
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(3) In [Job Attribute] dialog box, set to print in sliver ink monochromatic.

(4) From [Job List] panel, select 2 jobs, Silver plate and
color plate.

(5) Click [Composition]  icon.

(6) In [Composition] panel, the order of the job from the
bottom with the Silver plate → color plate, then click

 button.

(7) Click [Layer]  icon.

If you have created the data in RGB mode, you can not replace monochromatic color. 
Please create a silver plate with the following procedure.

(1) From [Job List] tab, select the job for Silver plate.

(2) Click [Special plate]  icon.

(3) Select “Valid pixel” in [Created area], and “Silver” in 
[Ink], and click the  button.
• The job of Silver plate is created.

 Conditions that can not be synthesized
• If you have set the number of copies to two or more
• Split Print
• Step-and-repeat
• If the set of the selected job and resolution is 

different
• Multiple page job
• If you have selected more than one cut jobs

 If you can not set a separate profile printing 
conditions, synthesize according to the 
conditions of one of the job.

1. First, select “Black” to 
replace the original color

2. Next, select  “Silver” in color 
after the replacement

3. Click  button

Create

Color plate

Silver plate

Composite
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(8) In [Layer Adjust] panel, select "Special Color → Color" to [Special Color Over Print].

(9) Click [Quality]  icon.

(10) Choose the job of Silver plate in  [job list] panel of
[Quality] panel.

(11) Set printing conditions with Print Quality tab.
1 Choose a metallic color profile.

2 In [Device Adjustment], specify the "profile settings".
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

• Here you do not need to set the [Quality]. 
When change the profile in step 3-(11), it will be the default setting of quality.

• Metallic color profile will have a [Si] to the end of the media name.

• If the density adjustment of silver ink is 
needed, specify the [Color Adjustment Set].

3
1

2
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(12) Choose the job of color plate in [job list] panel of
[Quality] panel.

(13) Set printing conditions with Print Quality tab.

(14) Click [Execution]  icon.
• Click  button.

• Please do not specify the metallic color profile.
• Be sure to specify the same resolution profile of the Silver plate of the profile.

Start
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Pull-back printing

Print part of the illustration in Metallic color
This section describes this procedure from data creation to printing using the steps required to set the
character text of the illustration below to metallic color and printing it using pull-back printing as an example.
By taking advantage of the swatch library of the metallic color, you can easily print the metallic color

1. Create metallic color plate and color plate.
(1) Select a character on the application.

(2) Specify any color from the MIMAKI SS21 Metallic Color Library.

(3) Click [Setting] of RasterLinkTools.

Example of printing Reference page

Print the part of the illustra-
tion in Metallic color P.30

• Please create always a data in CMYK mode.

Want to print a character in 
the color of the color 
swatches of metallic color.

Specify the word "OCEAN" to 
"S-07C" 

Specify the word "DEW" to 
"Cold_01"
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(4) Setting screen is displayed.
1 Check [Print Special Color Layer]
2 Click [Setup] button.

(5) Click [Output to RasterLink] of RasterLinkTools to save the hot folder of RasterLink.

(6) The color plate and metallic color plate of the data output to RL in step 1-(5) will be shown on the
RasterLink job list screen.

(7) Select the metallic color plate job on the job list
screen.

(8) Click [Color Replacement]  icon.

(9) Confirm the following two points on the “Color
Replacement” screen.
1 Check that the name of the spot color specified in 

step 1-(2) appears on the spot color list
2 Check that the concentration of the silver being 

output is set to 0 (Si:0)

2. Create a Silver plate.
(1) Select a job that was created in step 1-(6).

(2) Click [Special Plate]  icon.

(3) Click [Release] button.

• Check that RasterLink color collection settings have been configured for pull-back printing use 
before outputting to RasterLink. ⇒ P.11 “Choose the color collection”

1

2

1 2
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(4) Select the metallic color plate job on the job list
screen.

(5) Click [Special plate]  icon.

(6) In [Special plate] panel, create Silver
plate.

3. Print by synthesized.
(1) From [Job List] panel, select 3 jobs, Silver plate,

metallic color plate, and color plate.

(2) Click [Composition]  icon.

(3) In [Composition] panel, arrange the order of the jobs
from the bottom of the silver plate → color plate →
metallic color plate.

1. Select “Silver” in [INK]

2. Select “Valid pixel” in 
[Created area]

3. Click  
button

Create

Color plate

Silver plate

Metallic color plate
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(4) In [Composition] tab, select the color plate, check
[Pull back after Print], and click  button.

(5) Click [Layer]  icon.

(6) In [Layer] tab, select "Special Color → Color" in [Special Color Over Print].

(7) Click [Quality]  icon.

(8) Choose the job of Metallic color plate andsilver plate
in [job list] panel of [Quality] panel.

• Pull back media after printing the job that had a 
check in [Pull back after Print].

 Conditions that can not be synthesized
• If you have set the number of copies to two or more
• Split Print
• Step-and-repeat
• If the set of the selected job and resolution is 

different
• Multiple page job
• If you have selected more than one cut jobs

 If you can not set a separate profile printing 
conditions, synthesize according to the 
conditions of one of the job.

Composite
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(9) Set printing conditions with Print Quality tab.
1 Choose a metallic color profile.

2 In [Device Adjustment], specify the "profile settings".
3 Select the "ColorMatching OFF" in the preset of [Color Matching].

(10) Choose the job of Silver plate in [job list] panel of
[Quality] panel.

(11) Choose the job of color plate in [job list] panel of [Quality] panel.
• In [Print Quality] panel, choose the same resolution color profile of the metallic color profile.

(12) Click [Execution]  icon.
• Click  button.

• Metallic color profile will have a [Si] to the end of the media name.

• Please do not specify the metallic color profile.
• Be sure to specify the same resolution profile of the metallic color plate of the profile.

• If the density adjustment of silver ink is 
needed, specify the [Color Adjustment Set].

(3)
(1)

(2)

Start
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Frequently Asked Questions
Answer the frequently asked questions and troubles from customers.

There is no gloss of silver and metallic color 
Please check the settings of following items.

Setting item Settings

Check the settings of the 
[DRYING TIME] and the 
[LOGICAL SEEK]

• Follow the page 3 "Printer setting", make sure "DRYING TIM = 0.0s", and 
"LOGICAL SEEK = OFF".

Check the printing conditions 
of silver plate and metallic 
color plate.

• Profile
Make sure that the metallic color profile including the [Si] in the name of the media 
has been applied.

• Density adjustment
If you have made a density adjustment of silver ink, make sure that the color 
adjustment set is applied.

• Color matching 
Set the "ColorMatching OFF".
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